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BAB I. 
PENDAHULUAN 

1.1 Latar Belakang 

Peraturan Pemerintah Republik Indonesia Nomor 37 Tahun 2012 mengatur bahwa 
Daerah Aliran Sungai (DAS) adalah wilayah daratan yang menjadi satu kesatuan 
dengan sungai dan anak-anak sungainya. DAS memiliki fungsi penting dalam 
menampung, menyimpan, dan mengalirkan air dari curah hujan hingga menuju laut 
atau danau secara alami. Wilayah DAS dibatasi oleh batas topografis di darat dan 
batas wilayah perairan di laut yang masih dipengaruhi oleh aktivitas daratan, 
menjadikannya wilayah yang sangat penting dalam pengelolaan sumber daya air 
dan mitigasi bencana. 

Sebagai sebuah ekosistem alami, DAS terbentuk dari kumpulan wilayah yang 
dibatasi oleh punggung bukit, tempat air hujan yang jatuh akan mengalir menuju 
sungai-sungai hingga bermuara ke laut atau danau. Dalam ekosistem ini, terdapat 
dua wilayah utama: wilayah hulu sebagai sumber air dan wilayah hilir sebagai 
penerima air. Kedua wilayah ini saling berhubungan dalam sistem DAS yang lebih 
luas dan berfungsi sebagai area penangkapan air (catchment area), penyimpanan 
air (water storage), serta penyaluran air (distribution water) ke berbagai daerah 
(Halim, 2014). Keseimbangan antara wilayah hulu dan hilir sangat penting untuk 
memastikan distribusi air yang stabil dan menghindari kejadian ekstrem seperti 
banjir. 

Salah Satu DAS yang berada di Sulawesi Selatan yaitu DAS Tangka. DAS 
Tangka  adalah daerah aliran sungai yang terletak di tiga wilayah, yaitu Kabupaten 
Sinjai, Kabupaten Bone, dan Kabupaten Gowa, dengan luas 45837.27 hektar. 
Sungai ini sering menyebabkan banjir di beberapa daerah. Menurut data dari 
web.siandalan.sulselprov.go, yang dibuat oleh Badan Penanggulangan Bencana 
Daerah Pemerintah Provinsi Sulawesi Selatan, mencatat beberapa kejadian banjir 
yang terjadi di Kabupaten Sinjai dan Kabupaten Bone. Di Kabupaten Sinjai, banjir 
terjadi di Kecamatan Sinjai Utara dan Bulupoddo, dengan beberapa titik yang 
terkena dampak, seperti Kelurahan Lappa, Balangnipa, dan Bongki. Kejadian banjir 
pertama tercatat pada 6 Mei 2020, dan beberapa kejadian berikutnya terjadi pada 
tahun 2021 hingga 2023, menunjukkan bahwa banjir merupakan masalah berulang 
di wilayah ini. Misalnya, pada 27 Agustus 2021 dan 22 Juli 2022, banjir melanda 
beberapa kelurahan di Kecamatan Sinjai Utara, merugikan masyarakat setempat. 
Di Kabupaten Bone, hanya satu kejadian banjir yang tercatat, yaitu pada 7 
Desember 2021 di Kecamatan Tanete Riattang Timur, di Kelurahan Waetuo. Data 
ini menggambarkan dampak banjir yang beragam di dua kabupaten tersebut, 
mencerminkan tantangan yang dihadapi oleh masyarakat dalam mengatasi 
masalah banjir. 

Menurut Kamus Besar Bahasa Indonesia (KBBI), banjir merupakan peristiwa di 
mana wilayah daratan yang biasanya kering terendam akibat peningkatan volume 
air. Selain itu, definisi lain dalam kamus tersebut menyebutkan bahwa banjir adalah 
kondisi yang dipenuhi air dalam jumlah besar dan deras, yang terkadang meluap. 
Banjir merupakan salah satu masalah serius yang sering terjadi di wilayah DAS, 
terutama jika terjadi ketidakseimbangan antara aliran air yang datang dengan 
kapasitas tampung aliran sungai. Secara umum, banjir terjadi ketika volume air 
dalam saluran sungai melebihi kapasitasnya. Kodoatie (2021) menyebutkan bahwa 
banjir disebabkan oleh dua faktor utama, faktor alami dan aktivitas manusia. Faktor 
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alami meliputi curah hujan, fisiografi, erosi, dan sedimentasi yang mempengaruhi 
volume air di DAS, sementara aktivitas manusia, seperti perubahan penggunaan 
lahan, turut meningkatkan risiko banjir. 

Ada bebrapa jenis banjir yaitu, banjir luapan terjadi ketika air sungai, danau, 
atau saluran air meluap akibat debit air yang meningkat tajam, biasanya karena 
curah hujan tinggi atau aliran air dari hulu yang tidak mampu ditampung. Daerah 
yang terletak di dataran rendah atau dekat dengan aliran sungai besar sangat 
rentan terhadap jenis banjir ini, banjir bandang adalah jenis banjir yang datang 
secara tiba-tiba dengan aliran air yang sangat deras dan membawa material seperti 
lumpur, bebatuan, serta puing-puing. banjir ini biasanya terjadi di daerah 
pegunungan atau lereng akibat hujan deras yang memicu aliran air berkecepatan 
tinggi, Banjir rob adalah banjir yang terjadi akibat pasang air laut yang tinggi, sering 
kali diperparah oleh fenomena alam seperti badai atau kenaikan muka air laut 
akibat perubahan iklim. 

Menurut penelitian Nisarto (2016), DAS Tangka di Provinsi Sulawesi Selatan 
memiliki tingkat kerawanan banjir yang cukup tinggi. Hal ini disebabkan oleh 
ketidaksesuaian pola penutupan lahan, di mana lahan yang seharusnya berfungsi 
sebagai daerah tangkapan air malah dijadikan lahan pertanian oleh penduduk 
setempat. Akibatnya, DAS Tangka berpotensi menimbulkan bencana alam karena 
ketidaksesuaian pemanfaatan lahan. Ketidaksesuainya lahan sehingga 
menyebabkan peningkatnya aliran permukaan semakin meningkatkan jumlah hujan 
yang berubah langsung menjadi debit. Peningkatan aliran pada suatu daerah aliran 
sungai mengindikasikan peningkatan ancaman banjir di daerah tersebut. Beberapa 
penelitian yang dilakukan melaporkan, bahwa dengan adanya pembangunan dan 
peningkatan perubahan lahan dari lahan hutan menjadi lahan pemukiman, telah 
meningkatkan koefisien run off daerah tersebut. 

Menurut (Supit & Mamoto, 2016). Penggunaan lahan di suatu kawasan sangat 
mempengaruhi kondisi hidrologi DAS, begitu pula sebaliknya. Perubahan dalam 
jenis atau pola penggunaan lahan dapat berdampak langsung pada jumlah dan 
pola aliran air, baik dengan meningkatkan maupun mengurangi jumlah air yang 
dihasilkan. Selain itu, perubahan penggunaan lahan berdampak pada karakteristik 
hidrologi yang dapat menyebabkan perubahan pola aliran air, yang pada akhirnya 
berkontribusi pada kerawanan banjir di DAS tersebut. 

Dalam kaitannya dengan hal tersebut, proyeksi penutupan lahan dan curah 
hujan menjadi alat penting untuk menganalisis dampak perubahan penggunaan 
lahan dan kejadian hidrologi terhadap DAS dimasa depan. Model hidrologi sering 
digunakan karena dapat menyederhanakan sistem hidrologi yang kompleks dan 
memprediksi respons DAS terhadap berbagai kondisi, seperti curah hujan tinggi 
atau perubahan pola penggunaan lahan. Salah satu model yang sering digunakan 
adalah Soil and Water Assessment Tool (SWAT), yang mampu memprediksi 
dampak pengelolaan lahan terhadap hasil air dan sedimen di DAS (Supit & 
Mamoto, 2016). Keterkaitan antara perubahan penutupan lahan dan curah hujan 
menjadi kunci dalam memahami siklus hidrologi, di mana perubahan lahan 
memengaruhi aliran air, sedimen, dan risiko erosi, sedangkan curah hujan 
memengaruhi kejadian hidrologi ekstrem. Proyeksi ini sangat berguna untuk 
perencanaan tata ruang, pengelolaan sumber daya air, mitigasi bencana, dan 
konservasi lingkungan. 

Menurut (Supit & Mamoto, 2016). Untuk memahami lebih dalam dan 
memprediksi respons DAS terhadap perubahan penggunaan lahan dan kejadian 
hidrologi, model hidrologi sering digunakan. Model hidrologi memberikan gambaran 
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sederhana mengenai sistem hidrologi yang kompleks dan berguna dalam 
memprediksi respons DAS terhadap berbagai kondisi, seperti curah hujan tinggi 
atau perubahan pola penggunaan lahan. Salah satu model yang digunakan adalah 
Soil and Water Assessment Tool (SWAT), yang dapat memprediksi dampak 
pengelolaan lahan terhadap hasil air dan sedimen di DAS  

Selain itu, model HEC-RAS (Hydrologic Engineering Centre - River Analysis 
System) dapat menyajikan simulasi banjir secara visual dalam bentuk 2D dan 3D. 
Melalui model ini, informasi mengenai kecepatan, genangan, dan kedalaman banjir 
dapat diperoleh, sehingga pengelolaan DAS dapat dilakukan lebih efektif dan 
prediksi banjir menjadi lebih akurat. Oleh karena itu, Penelitian ini menggunakan 
pemodelan SWAT dan HEC-RAS untuk mensimulasikan kejadian banjir di DAS 
Tangka. Melalui simulasi ini, diharapkan dapat diketahui wilayah-wilayah yang 
tergenang akibat banjir dan dilakukan pencegahan atau mitigasi guna mengurangi 
resiko pada daerah yang terdampak banjir.  

1.2 Tujuan dan Manfaat 

Penelitian ini bertujuan meengidentifikasi daerah yang  terdampak banjir di DAS 
Tangka menggunakan pemodelan hidrologi dan hidrolika berbasis spasial. Manfaat 
dari penelitian ini adalah untuk memberikan informasi kepada instansi terkait guna 
meningkatkan upaya mitigasi bencana, terutama dalam hal banjir.  
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BAB II.  

METODE PENELITIAN 

2.1 Waktu Dan Tempat Penelitian 

Penelitian ini dilakukan mulai Bulan Agustus 2023 hingga November 2024 pada 
DAS Tangka yang secara administrasi berada pada Kabupaten Sinjai, Kabupaten 
Bone, Kabupaten Gowa Sulawesi Selatan, sebagaimana pada Gambar 1 dan 
Analisis data dilakukan di Laboratorium Perencanaan dan Sistem Informasi 
Kehutanan, Fakultas Kehutanan, Universitas Hasanuddin, Makassar.        

 
Gambar 1. Peta lokasi penelitian 
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2.2.  Bahan dan Alat 

Alat-alat yang digunakan dalam penelitian ini adalah: 
1. Alat Tulis, digunakan untuk menuliskan semua keterangan data di lapangan 
2. Kamera(menggunakan kamera Handphone), untuk dokumentasikan kegiatan 

lapangan. 
3. Aplikasi Avenza merupakan aplikasi mobile GPS yang digunakan untuk 

melakukan survey lapangan 
4. Komputer/Laptop yang dilengkapi dengan software Sistem Informasi Geografis 

(SIG) yang telah terintegrasi dengan Soil and Water Assessment Tool (SWAT), 
Hydrologic Engineering Center-River Analysis System (HEC-RAS), plugin 
bernama Modeling Land Use Change in Surface Water Catchments 
(MOLUSCE) dan aplikasi Statistical Bias Correction for Climate Scenarios 
(SiBiaS) 

Bahan-bahan yang digunakan dalam penelitian ini yaitu: 

Tabel 1. Bahan-bahan penelitian 

No. Bahan Kegunaan Sumber 

1. Data DEM 
Nasional  

Digunakan untuk menghasilkan 
batas DAS, kelerengan pada 
proses pemodelan di software 
SWAT 

Badan Informasi Geospasial 
(BIG) 

2. Peta Batas   DAS 
Tangka 

Sebagai unit analisis untuk 
menentukan lokasi kajian 

SK.304/MENLHK/PDASHL/
DAS.0/7/2018 

3. Data Debit 
Tahun 2023 

Digunakan dalam proses 
kalibrasi dan validasi model 
SWAT 

Balai Besar Wilayah Sungai 
Pompengan Jeneberang 
(BBWSPJ) 

4. Peta Jenis Tanah Digunakan untuk proses 
pemodelan SWAT 

Data Sistem Lahan  
(Landsystem) RePPProT, 
Badan Koordinasi Survey  
dan Pemetaan Nasional  
Tahun 1987 

5. Citra Landsat 8 
TIRS/OLI Path 
Row 114-63 
tahun 2013-2023 

Sebagai bahan analisis untuk 
membuat peta penutupan 
lahan DAS Tangka tahun 2023 
sehingga di gunakan untuk 
pemodelan SWAT 

 Earth Explorer 

6. Peta Administrasi Untuk mengetahui administrasi 
di wilayah DAS. 

Badan  Informasi 
Geospasial 
(tanahair.indonesia.go.id) 

7. Data Iklim Tahun 
(2013-2023)  

Sebagai input dalam 
pemodelan SWAT 

Satelit Merra 
(power.larc.nasa.gov). 
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2.3 Prosedur Penelitian 

Prosedur penelitian ini melalui beberapa tahapan, yaitu mulai dari identifikasi tanah 
longsor, pengumpulan data dan olah data serta analisis data dan validasi. Bagan alur 

penelitian dapat dilihat pada Gambar 2. 

 

Gambar 2. Bagan Alur Penelitian
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2.4 Persiapan dan Penyiapan Data 

Data Penutupan Lahan 

Data penutupan lahan DAS Tangka diperoleh dari menginterpretasi citra landsat 8 
Path 114 Row 62 tahun 2013, 2018 dan 2023 dan Proyeksi penutupan lahan tahun 
2032 menggunakan tools MOLUSCE  dengan tahapan sebagai berikut: 

1. Mengonversi data tutupan lahan dari format data vektor menjadi data raster 
2. Persiapan data faktor pendorong yakni jarak dari jalan sesuai dengan batas DAS 

Tangka dan mengubahnya menjadi data raster 
3. Memasukkan data penutpan lahan dan data factor pendorong kedalam QGIS dan 

memasukkannya kedalam Plug-in MOLUSCE  

 Memasukkan data tahun awal ke “Initial” 

 Memasukkan data tahun akhir ke “Final” 

 Memasukkan data factor pendorong ke “Spatial Variabel” 

 Jika sudah ,Klik “Check Geometry” 

 Ketika pemberitahuan “Geometry is Mathced” muncul, kita sudah bisa lanjut ke 
tahap selanjutnya 

4. Tahap “Evaluating Correlation” 
5. Tahap “Area Changes” 
Tahap ini melihat perubahan yang terjadi pada area kajian berdasarkan data 

tutupan lahan  
6. Tahap “Area Changes” 
7. Tahap “Transition Potential Modelling” 
8. Tahap “Cellular Automata Simulation” 
9. Tahap “Validation” 
10.Hasil proyeksi penutupan lahan 

Citra satelit yang disediakan oleh United States Geological Survey (USGS) 
dapat diunduh melalui situs web http://earthexplorer.usgs.gov. Untuk menganalisis 
penutupan lahan, digunakan metode delineasi visual yang mengandalkan 
identifikasi pola, karakteristik rona, warna, serta tekstur dari citra tersebut guna 
menentukan kelas penutupan lahan. Setelah proses delineasi, pengecekan 
lapangan dilakukan untuk memverifikasi kesesuaian antara hasil analisis citra dan 
kondisi nyata di lapangan, sehingga data yang diperoleh lebih akurat dan relevan. 

Pengujian ketelitian atau akurasi dari hasil interpretasi merupakan langkah 
yang sangat penting dalam aplikasi penginderaan jauh, karena suatu hasil 
interpretasi layak atau tidaknya untuk digunakan tergantung pada seberapa besar 
tingkat ketelitian hasil interpretasi. Uji akurasi dilakukan dengan menentukn 
banyaknya titik lokasi survey lapangan dengan rumus menggunakan persamaan 
distribusi multinomial (Congalton, 2008 dalam Putri et al., 2018).   

 

(1) 

Dimana : 
n : Jumla Sampel 
B : nilai yang didapat dari tabel chi square berdasarkan jumlah kelas 

 : kelas khusus yang mencakup area terbanyak dalam peta 

 : tingkat ketidak percayaan dalam % 

http://earthexplorer.usgs.gov/
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Setelah menentukan titik sampel selanjutnya membuat purposive sampling  
pada peta dan  kemudian dicek dilapangan tipe penutupan lahannya. Perhitungan 
akurasi interpretasi citra dilakukan dengan metode confusion matrix. Setelah  
memperoleh data tabel  confusion matrix maka selanjutnya akan dilakukan 
pengujian akurasi dengan menggunakan perhitungan kappa accuracy. 

Tabel 2. Confusion Matrix  

 
Data Acuan (pengecekan Lapangan) Total 

Kolom  A B C 

Data Hasil 
Klasifikasi 
Citra 

A’ Xn   Σn+ 

B’     
C’   Xn  

Total Baris  Σ+n   N 

 
Menurut Jaya, 2010 dalam  Sampurno, R. M., & Thoriq, A. (2016), saat ini 

akurasi yang  dianjurkan adalah akurasi kappa, karena overral  accuracy secara 
umum masih over estimate.  Akurasi kappa ini sering juga disebut dengan  indeks 
kappa. Akurasi yang disarankan untuk digunakan adalah akurasi kappa karena uji 
akurasi ini  menggunakan semua elemen dalam  matriks,  nilai akurasi yang 
memenuhi syarat yang ditetapkan oleh USGS Amerika  yang menyatakan ketelitian 
interpretasi lebih dari 85%. Apabila tingkat keakurasian sudah melebihi 85% maka 
sudah menunjukkan ketelitian yang cukup tinggi. Secara matematis akurasi kappa  
disajikan sebagai berikut: 
 

 

(2) 

Dimana : N = total data (piksel) yang diuji 
     Xn = nilai diagonal matriks baris ke-n dan kolom ke-n 
     Xn+ = jumlah piksel dalam baris ke-n 
     X+n = jumlah piksel dalam kolom ke-n 

Data Jenis Tanah 

Parameter data jenis tanah dalam model SWAT adalah data tanah yang berupa 
jenis tanah serta parameter fisik dan kimia tanah yang diperoleh dari data 
landsystem Regional Physical Planning Programme for Transmigration (RePPProt). 
Badan Kordinasi Survey dan Pemetaan Nasional Tahun 1987 dan data Web Soil 
USDA National Resource Conservation Service yang telah ditambahkan ke dalam 
model SWAT. Berikut Parameter Tanah Model SWAT:  

Tabel 3. Parameter Tanah Model SWAT 

No Parameter Tanah Kode SWAT 

1 Jumlah Lapisan Tanah NLAYERS 

2 Kelompok Hidrologi Tanah HYDGRP 

3 Kedalaman Akar Tanaman (mm) SOL_ZMX 



9 
 

No Parameter Tanah Kode SWAT 

4 Porositas Tanah (fraction) ANION_EXCL 

5 Volume Retak Tanah (m3/m3) SOL_CRK 

6 Tekstur TEXTURE 

7 Kedalaman Tanah (mm) SOL_Z 

8 Bulk Density (g/cm3) SOL_BD 

9 Kapasitas Air tersedia (mm/mm) SOL_AWC 

10 Kadar C Organik (%) SOL_CBN 

11 Konduktivitas Hidrolik Jenuh (mm/Hari) SOL_K 

12 Persentase Liat (%) CLAY 

13 Persentase Debu (%) SILT 

14 Persentase Pasir (%) SAND 

15 Persentase Batu Permukaan (%) ROCK 

16 Albedo Tanah (fraction) SOL_ALB 

17 Erodibilitas Tanah USLE_K 

18 Konduktivitas Listrik (ds/m) SOL_EC 

19 Kalsium Karbonat (%) SOL_CAL 

20 pH SOL_PH 

Data Iklim 

Data iklim diperoleh dari data satelit yang dapat di unduh di web 
https://power.larc.nasa.gov/data-access-viewer/. Tahapan dalam melakukan 
download data iklim sebagai berikut: 
1. Menentukan batas wilayah kajian sebagai batasan dalam pengambilan data 

iklim 
2. Membuat grid pada wilayah kajian dengan interval 5 km kemudian menentukan 

titik koordinat pada masing-masing grid sebagai titik stasiun 
3. Mengakses pada link power.larc.nasa.gov kemudian memilih menu Power Data 

Acces Viewer. Setelah masuk pada menu tersebut, klik POWER Single Point Data 
Acces 

4. Input titik koordinat stasiun pada poin latitude/longitude kemudian melakukan 
penyesuaian data sesuai kebutuHan dengan output format CSV, setelah itu klik 
submit → CSV → download. 
Data iklim yang dibutuhkan dalam model SWAT berupa data iklim periode 

bulanan 2014-2023 yang meliputi curah hujan (mm), temperature maksimum dan 

https://power.larc.nasa.gov/data-access-viewer/
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minimum (℃), radiasi matahari (MJ/m2), kelembaban udara (%) dan kecepatan 
angin (m/s) yang diolah kedalam bentuk file WGN (Weather Generator Data). data 
iklim tersebut berupa data bulanan kemudian di kumpulkan kedalam file PCP, TMP, 
SOLAR, RH dan WIND dengan ekstensi .txt. Data Iklim juga dilakukan proyeksi 
menggunakan program SiBiaS khususnya untuk data curah hujan dan suhu 
bulanan. 
Proyeksi iklim dilakukan dengan tahapan sebagai berikut: 
1. Menyiapkan data curah hujan yang diperoleh melalui tahapan pengumpulan 

data pada Sub Bab Data Iklim. 
2. Melakukan penyesuaian terhadap inputan data berdasarkan format 

penyusunan data yang telah ditentukan. 
3. Data curah hujan yang telah disesuaikan kemudian diinput masuk kedalam 

software. Selanjutnya, secara otomatis software akan membaca data observasi 
yang telah dimasukkan serta secara otomatis mengkalkulasikan tahun proyeksi 
yang akan dihasilkan. 

4. Memilih scenario yang akan digunakan, dalam penelitian ini menggunakan 
skenario RCP4.5 dan GCM CSIRO Mk3.6.  

5. Tahapan selanjutnya, melakukan simulasi dengan menekan tools start 
calculation pada menu. Hasil proyeksi kemudian dapat dilihat pada folder 
penyimpanan. 

2.5 Input dan Analisis Data Pemodelan SWAT 

Deliniasi Batas DAS 

Penentuan batas DAS diperoleh dari kegiatan Delineasi batas DAS pada ekstensi 
SWAT yang terintegrasi pada software ArcGIS. Delineasi DAS Tangka diperoleh 
dari ekstraksi data DEMNAS yang lokasinya telah disesuaikan dengan batas DAS 
Tangka. Delinasi batas DAS dilakukan sebagai berikut;  
1. Membuat project SWAT menggunakan menu Swat Project→New Swat 

Project→Menyimpan file project pada folder yang telah disiapkan; 
2. Menginput Data DEM yang telah dibuat pada Sub Bab Persiapan dan 

Penyiapan Data DEM menggunakan menu Watershed Deliniator→ Automatic 
Watershed Deliniation →Memilih data DEM yang akan digunakan; 

3. Selanjutnya melakukan kalkulasi data pada menu Watershed Deliniator → Flow 
direction and Accumulation. 

4. Menentukan jaringan sungai menggunakan menu Stream network → Create 
streams and outlets. 

5. Menentukan outlet (outlet definition) menggunakan menu Wholewatershed 
outlet→ menyeleksi outlet sungai lokasi penelitian →Deliniate watershed. 

6. Melakukan perhitungan parameter Sub DAS (calculate subbasin parameter). 
Tahapan Deliniasi Sub Das selesai dilakukan. 

Pembentukan Hydrological Response Unit (HRU) 

Hydrological Response Unit atau HRU merupakan unit terkecil dalam skala analisis 
yang dilakukan pada pemodelan SWAT. Pembentukan HRU dilakukan dengan 
overlay peta penutupan lahan, peta jenis tanah dan data kemiringan lereng. Setiap 
HRU yang terbentuk berisi informasi spesifik mengenai lahan tersebut yang 
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mencakup penutupan lahan, jenis tanah, dan kemiringan lereng . .Data penutupan 
lahan dan jenis tanah yang digunakan dalam analisis HRU berformat raster ESRI 
sedangkan klasifikasi kelas lereng berasal dari dataset DEM yang digunakan untuk 
mendelineasi batas DAS. Dataset yang digunakan menggunakan sistem proyeksi 
yang sama (Ditjen Bina Pengelolaan DAS dan Perhutanan Sosial, 2014), dengan 
tahapan: 
1. Menginput peta penutupan lahan dan jenis tanah yang telah diatur ke dalam 

format raster dan menggunakan system koordinat UTM. Tahapan awal dalam 
membuat data HRU yakni menggunakan menu HRU Analysis→Land 
Use/Soils/Slope Defenition. 

2. Menginput peta penutupan lahan menggunakan tools Land Use Data→memilih 
data penutupan lahan→Choose grid fields→value→Lookup table→pilih data 
tabulasi penutupan lahan yang telah dibuat dengan ekstensi txt→reclassify; 

3. Menginput peta jenis tanah menggunakan tools Soil Data→memilih data jenis 
tanah→Choose grid fields→value→Soil Database Options→User Soil→Lookup 
table→pilih data tabulasi jenis tanah yang telah dibuat dengan ekstensi 
txt→reclassify; 

4. Melakukan parameterisasi kelerengan menggunakan tools Slope→ 
memasukkan 5 kelas kelerengan (0-8%, 8-15%, 15-25%, 25-45%,>40%) → 
reclassify; 

5. Ketiga data tersebut kemudian dilakukan proses overlay untuk membentuk 
kombinasi informasi dari setiap data yang menjadi karakteristik pada setiap sub 
DAS. HRU yang terbentuk kemudian didefinisikan dengan batas nilai sebesar 
0% untuk mendapatkan jumlah kombinasi HRUs yang optimal. 

Input Data Iklim Harian 

Penggabungan Input data iklim dengan data HRU (Hydrological Response Unit) 
dilakukan setelah pembentukan HRU telah selesai. Pada tahap ini dilakukan 
penginputan data sebanyak 2 kali yaitu data HRU tahun 2023 dan HRU proyeksi 
tahun 2032. Input data iklim dilakukan dengan pemanggilan file WGN (Weather 
Generator Data) yang telah dikerjakan sebelumnya. data tersebut yaitu series curah 

hujan (mm), temperatur udara (℃), radiasi matahari (MJ/m2/hari), kelembaban 
udara (%) dan kecepatan angin (m/s). Data dikumpulkan kedalam file PCP untuk 
curah hujan, TMP untuk temperatur atau suhu, SOLAR untuk radiasi matahari, RH 
untuk kelembaban udara dan WIND  untuk kecepatan angin dengan ekstensi .txt, 
proses simulasi dijalankan berdasarkan periode harian. 

Running ArcSWAT dan Output Simulasi 

Proses simulasi dilakukan dengan running SWAT setelah mendapatkan output dari 
proses penggabungan HRU dengan data iklim. Running model SWAT dijalankan 
pada menu SWAT Simulation dengan syarat tahapan Watershed Delineation, HRU 
Analysis dan Write Input Table telah selesai dijalankan dengan sukses, tahapan ini 
dilakukan sebanyak 2 kali  dengan data actual dan data proyeksi. Setelah tahapan 
running telah selesai dilaksanakan, Output yang dihasilkan ialah data RCH. 
Informasi  yang terdapat dalam data RCH adalah  hasil debit air dengan kode 
FLOW_OUT yang dapat di ambilkan dengan menggunakan sub menu read SWAT 
output. Pada penelitian ini data yang diperlukan ialah data debit air dengan kode 
FLOW_OUT, hasil dari simulasi disimpan untuk keperluan analisis berikutnya  
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Kalibrasi dan Validasi Model 

Proses kalibrasi memiliki tujuan utama untuk mendekati hasil output dari model 
dengan nilai yang sebenarnya di Daerah Aliran Sungai (DAS). Untuk mencapai hal 
ini, dilakukan penyesuaian pada beberapa parameter sensitif yang memiliki dampak 
signifikan terhadap nilai hasil simulasi. Pengujian kalibrasi dilakukan dengan 
menggunakan metrik evaluasi, termasuk Koefisien Determinasi (R2) dan Indeks 
Nash-Sutcliffe (NSI). 

Koefisien Determinasi (R2) digunakan untuk mengevaluasi sejauh mana 
nilai hasil simulasi model SWAT mendekati nilai yang dihasilkan oleh model SCS 
yang diasumsikan sebagai representasi terdekat kondisi lapangan sesungguhnya. 
Nilai R2 mendekati 1 menandakan bahwa hasil simulasi memiliki tingkat kesesuaian 
yang tinggi dengan nilai sebenarnya.  

2.6 Simulasi Model HEC-RAS 

Simulasi model HEC-RAS dapat dilakukan dengan mengatur periode waktu dan 
besaran waktu keluaran data yaitu: harian, bulanan dan tahunan. Pada penelitian ini 
simulasi HEC-RAS dijalankan pada periode harian. Adapun tahapannya yaitu: 
1. Penyiapan data terrain di Ras Mapper. 

Tujuannya untuk membuat image dan proyeksi dengan memasukkan data 
terrain di ras mapper, adapun yang dihasilkan adalah image yang sudah 
terproyeksi dengan daerah penelitian. 

2. Penyiapan area aliran 2 dimensi. 
Tujuannya untuk membuat mesh dengan mendigitasi disekitar sungai 
membentuk poligon tertutup. Untuk menentukan ukuran Mesh di generate 
computation point on regular interval with all breakline, apabila terjadi error 
hapus point yang error tersebut dengan remove point. Yang diHasilkan dari 
proses ini adalah mesh dengan jumlah cell bergantung dari ukuran grid yang 
akan dimasukkan. 

3. Penyiapan boundary condition. 
Tujuannya untuk membuat batasan di hulu dan di hilir dalam simulasi dengan 
menggunakan SA/2D area BC line yang dihasilkan dari proses ini adalah up 
Strean dan down stream 

4. Pemilihan skenario aliran. 
 Tujuannya untuk menentukan skeneraio yang akan digunak untuk simulasi. 

Terdapat 2 skenario aliran yang digunakan pada Softwere HEC-RAS yaitu 
Steady flow dan aliran unsteady flow. Pada penelitian ini digunakan skenario 
unsteady flow (aliran tak permanen). 

5. Pemasukan data unsteady berupa data debit sungai terkalibrasi 
6. Proses running, Tujuannya untuk melakukan simulasi, adapun yang dihasilkan 

ada model genangan yang akan terjadi pada suatu daerah. 

 
2.7 Mitigasi Bencana 

Mitigasi bencana banjir dapat dilakukan dengan memperbaiki parameter penyebab 
debit banjir, Salah satu bentuk mitigasi alami untuk mengendalikan aliran 
permukaan dan debit air adalah melalui perencanaan tata guna lahan yang 
terencana dengan baik (Chairil et al., 2020). Mengingat hutan berperan penting 
dalam mengatur aliran air dan mencegah erosi. Kawasan hutan yang memiliki 
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tutupan vegetasi yang baik mampu menyerap air hujan lebih efektif, mengurangi 
limpasan permukaan, dan menurunkan risiko banjir. Oleh karena itu, upaya 
pelestarian dan rehabilitasi hutan menjadi langkah strategis dalam mengurangi 
potensi bencana banjir. 
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